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Fs ’ Enclosure Integrity Test Procedure

Background:

Many high value zones are protected by fire suppression gases such as Halon and the
more recent Clean Agents such as FM-200, Sapphire, Ecaro 25, Inergen, Argonite etc. Upon
detection of a fire, these agents are released into the protected zone.

In order to provide the proper protection, the fire suppression gas must be retained in the
zone for a significant period of time to assure extinguishment of the fire, prevent re-ignition of
the fire and to allow time for the arrival of the fire and security personnel.

The first fire suppression gas used in occupied spaces was Halon. In order to assure that
the Halon concentration would be retained in the zone a discharge test was performed and using
a concentration meter the “hold” time was determined. If the zone was not properly sealed, the
Halon concentration would escape and the required hold time would not be obtained.

Due to environmental reasons beginning in 1990 Halon was replaced by the current
“Clean Agents”. Though a discharge test could be conducted with the clean agents, it has be-
come cost prohibitive. The Enclosure Integrity Test Procedure was developed to measure the
actual leakage areas and to predict the “hold” time.

Standards:

NFPA 2001 Standard on Clean Agent Fire Extinguishing Systems, Section 7.7.2.3 Re-
view Enclosure Integrity (acceptance testing).

NFPA 2001 Standard on Clean Agent Fire Extinguishing Systems, Annex C Enclosure
Integrity Procedure.

Principle:

Enclosure Integrity Test Procedure is based on the “door fan” test procedure which was
developed to determine the leakage area in buildings for energy conservation. Using a similar
procedure and calculations the leakage area and therefore the “hold” time for the suppression
gas concentration can be predicted.

Equipment:

A calibrated (CFM), variable speed fan; door frame and cover to hold the fan; digital
micro-manometer pressure gauges; computer with appropriate software plus various test acces-
sories such the TEC-2003-DK FST Digital Enclosure Integrity Test Kit by Fire Safety Technol-

ogy or equivalent.
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Fs ’ Enclosure Integrity Test Procedure

Test Procedure:

Upon arrival the technician will survey and measure the protected zone to accurately
establish the as built dimensions and the height of the protected equipment. He will also deter-
mine a suitable doorway for locating the test equipment and will survey the area surrounding
the protected zone to assure a free return air path back to the fan.

The zone data, gas type and concentration will be entered into the test program.

After the equipment is set up in the selected doorway, the zone must be placed in dis-
charge status: dampers on incoming duct work closed. In an actual fire emergency it is recom-
mended that self contained air handlers be shut down as well as all UPS units and all electri-
cally operated equipment. For the Enclosure Integrity Test this equipment may remain operat-
ing. During the actual test, all doors must remain closed. Personnel may remain in the zone.

Per the test procedure the zone will be pressurized and de-pressurized to the column
pressure created by the suppression / air gas mixture usually in the range of 10 to 20 pa ( .0015
to .0030 psi )and the required air flow recorded. The average leakage area and “hold” time will
be calculated.

If the “hold” time is less than is required the technician may assist in locating possible
leakage areas. These indicated areas may or may not be all the leakage areas. This is service is
provided as a courtesy with no responsibility to determine all leakage areas. For further guid-
ance on typical leakage areas please refer to our publication “Sealing of Rooms for Contain-
ment of Fire Suppression Agents.”

Following the test a full written test report will be distributed within one week.

For more information on the test procedure and requirements please refer to NFPA
2001 Standard on Clean Agent Fire Extinguishing Systems, Annex C: Enclosure Integrity Pro-
cedure.

Annual Inspection, Testing:

NFPA 2001 Standard on Clean Agent Fire Extinguishing Systems, Section 7.4 Enclo-
sure Inspection (annual inspection and retesting of zone).

Fire Safety Technology

P.O. Box 1063
Severna Park, MD 21146 U.S.A.
Phone 800-685-8303, 410-647-8303
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l's 1’ Conducting a Enclosure Integrity

Test
A Photo Summary

1. Arriving at test site, equipment easily
fits in suv or work van.

3. Rolling into test zone

6. Assemble door frame
5. Unpack door frame

Fire Safety Technology




Fs 1’ Conducting a Enclosure Integrity

Test
A Photo Summary

"\
L&

8. If door closer blocks
door frame it will have

to be removed 9. Drop in cross bars

7. Place frame in door for trial fit.

12. Install panel on door
frame

11. Unpack door panel

13. Install green tubing
through patch on door

Fire Safety Technology




Fs 1’ Conducting a Enclosure Integrity

14. Measure the zone, here the
maximum protected height

17. Enter zone data and meas-
urements into EIT Quick Test
2001

Test
A Photo Summary

15. Measure height of equipment
(hazard), the minimum protected
height—also measure length and
width of zone

16. Make sketch of zone and
record measurements on the
test data form

X

Frotected
Zone

18. Survey the area surrounding the test
zone to assure a free return air path to fan.

Fire Safety Technology




FST

19. Install door frame with panel
into the test door

22. Install fan into frame with
white flow rings facing you

Conducting a Enclosure Integrity

Test
A Photo Summary

20. Using toggle cams lock
frame into the test door

21. Extend green outside
air pressure tube away
from fan

23. Clamp speed control
board to cross bar

24. Place check list (“cheat
sheet”) in front of board and
hold in place with the DG-
700 digital gauge

Fire Safety Technology




FST

25. Attach red fan pressure tube to

top right nipple on gauge

28. Again make sure all tanks
are disconnected

Conducting a Enclosure Integrity

Test
A Photo Summary

oN/ -
A UGHT ﬂ

me ENERGY
CONSERVATORY

26. Attach other end of the red
fan pressure to nipple on fan

27. Attach green outside pres-
sure tube to lower left nipple

29. Have experience alarm tech-
nician, call out alarm system,
silence building alarm, and cy-
cle panel to activated any
HVAC dampers connected to
panel

Fire Safety Technology




Fs 1’ Conducting a Enclosure Integrity

Test
A Photo Summary

31. Remove blocking plate
and flow rings “C”, “B”, “A”
as necessary

30. Turn on gauge -see cheat

sheet- With fan completely 32. Turn on fan and bring up to
closed and all HVAC dampers pressure within the “target pres-

closed measure the static sure range”—record pressure and
(bias) pressure flow

33. Turn fan around

34. Connect “T” tube to lower
nipples and to green outside
pressure tube

35. Turn on fan and bring up to
target pressure range—record

36. Enter all test data into EIT Quick Test
which will calculate the predicted hold time

Fire Safety Technology
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Conducting a NFPA 2001 Enclosure Integrity Test

Part 1 Preliminary Survey and Review

A. Upon arrival at the room to be tested:
Make sure the suppression gas tanks are disarmed.

Then take time to familiarize yourself with the room. Check and note the following:

1. Obvious sources of leaks in room but particularly above ceiling and under a
raised floor: cable trays, conduits and raised floor panels if the lead out of
room.

2. Duct work through walls, are dampers present?

3. Air conditioners and air handling systems in room?

4. Location of room in relation to the building (outside wall?) and surrounding
rooms.

5. Determine free air passage to and from door that will be used for the test. Do

outside doors or stair well doors need to be kept open?
6. Construction of room:

Sheet rock, is it sealed at floor?
Block, is it painted?
Walls, do they go deck to deck or deck to roof?
are they sealed at overhead deck or roof?
Doors, do the have wiper or drop seals at floor and are they sealed
around jam?
are the always closed or are they self closing at alarm?
Widows, are the sealed (silicone caulk recommended)?

7. Review drawings and room specifications, verify with tape floor heights,
ceiling height, roof height and room dimensions. Calculate cubic feet of
protected volume.

8. Inspect suppression system, determine piping corresponds to the zone to be
tested, note and verify total fill weights of cylinders. Are the cylinders
disarmed?

9. Review calculations.

B. After the initial inspection, review with the alarm installer and building engineer:

1. Sealing work that has taken place and who is responsible for sealing.

Fire Safety Technology

P.O. Box 1063
Severna Park, MD 21146 U.S.A.
Conducting NFPA 2001 EIT Part 1 10 27 2016.pub Phone 800-685-8303, 410-647-8303
FAX 410-647-7066
Page 1 e-mail: mail@firesafetytech.com

www.firesafetytech.com




2. HVAC status at discharge: Self-contained and/or building air handlers shut
down?

Dampers closed?
3. Door status at discharge: Are closers activated?

C. Review with AHJ the minimum required protected height (for a concentration test this would
be the height of the highest probe)?

D. At this time install door frame, fan and control module and prepare for test. Be sure outside
air pressure sampling tube is attached to door frame. While this is taking place the outside
doors and/or stairwell doors should be blocked opened. Doors on neighboring rooms should
also be opened. The system installer should place the alarm system in discharge mode (make
sure system tanks are disarmed) with all dampers closed and air handlers shut down.

E. Now start the door fan test.

The blower door testing equipment, software and instruction manuals have been designed, built, calibrated,
and written in accordance to the NFPA 2001, 2000 Appendix C Enclosure Integrity Procedure by the The Energy
Conservatory and by Fire Safety Technology a division of Worldwide Trade & Services, Inc. However it is the
responsibility of the company (individual) conducting the enclosure integrity test and the authority having jurisdiction
supervising the test to assure all tests are conducted in full compliance with the NFPA procedure. Neither The Energy
Conservatory nor Fire Safety Technology, assume any responsibility or liability for any errors or omissions nor assume
any responsibility or liability for the passage of a discharge test and/or for maintaining the specified concentration for
the predicted time in case of an actual emergency.

Fire Safety Technology

P.O. Box 1063
Severna Park, MD 21146 U.S.A.
Phone 800-685-8303, 410-647-8303
FAX 410-647-7066
Page 2 e-mail: mail@firesafetytech.com
www.firesafetytech.com




Conducting a NFPA 2001 Enclosure Integrity Test

Part 2 Using the Model 3 Blower Door
and the DG 700 Digital Gauge

Make sure the fire suppression gas tanks are disarmed .

1. Install the Blower Door system (see chapters 2 and 3, pages 7 to 19 in the Minneap-
olis Blower Door Operation Manual, and Conducting a Enclosure Integrity Test, A Pho-
to Summary).

a. Install the aluminum frame and nylon panel in the selected door.

b. Attach the gauge mounting board and fan speed controller to a door or to the
aluminum frame gauge hanger bar using the C-clamp on the back of the mounting
board.

c. Place the DG-700 pressure gauge onto the mounting board (using the Velcro
strips) in front of the “Cheat Sheet” and connect tubing to the DG-700 for the de-
pressurization test as shown below.

Note: Normal setup is with the technician inside the protected zone. If you setup

outside the protected zone see Setup Inside or Outside Zone?

Connect the Green
tubing to the Channel

A Referenge Tap. Connect the Red tubing
Channel A is used to

e to the Channel B Input
measure room (zone) tap

pressure with refer-
ence to the area out-
side the room.

Channel B is used to
measure fan pressure
and flow.

Green to outside

\il_l—l_l? Red to fan

De-pressurization Set Up

d. Run approximately 3 — 5 feet of the remaining end of the Green tubing outside
through one of the patches in the bottom corners of the nylon panel. Be sure the outside
end of the tubing is well away from the exhaust flow of the Blower Door fan.

Hint: Keep the green tube installed in the nylon panel. It will save time
setting up and will remind you to have green tube properly installed.

e. Install the Blower Door fan, with the flow rings and no-flow plate installed,
into the large hole in the nylon panel. The exhaust side of the fan should be outside (the
side with the chrome grill), and the inlet side of the fan (the side with the flow rings)
should be inside facing the operator.

Using the Model 3 and DG 700 rev 10/27/2016.pub
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f. Insert the female plug from the fan speed controller into the receptacle located
on the fan electrical box. The remaining cord (power cord) should be plugged into a pow-
er outlet that is compatible with the voltage and wattage of the fan motor.

g. If the fan is equipped with a fan direction switch be sure it is set to exhaust air
out of the zone.

h. The remaining end of the Red tubing should now be connected to the pressure
tap on the Blower Door fan electrical box.

2. Prepare for test:

a. Cycle fire suppression control panel through to discharge mode to activate any
dampers, HVAC controls, etc. which are controlled by the panel.
b. Be sure to have a free return air path from the outside of all the protected zone
walls back to the fan. (Open all doors to connecting closets, offices, etc.)
(Important See Free Return Air Flow Path)
c. Turn on computer, start EIT Quick Test 2001 and type in the room and location
data. (See EIT Quick Test Intl. Manual)

3. Bias (Static) Pressure
a. Using the ON /OFF button, turn on the DG-700. (For more detailed instructions
see Operating Instructions for the DG-700 Pressure and Flow Gauge)

1. Press the MODE button once to select PR/ FL. Indicating operating in
the Pressure / Flow Mode.

2. In the DEVICE window confirm that you are set up for the BD 3 fan.
(Later we will use the CONFIG button to change to our selected flow

ring.)

3. In the pressure and flow windows confirm you are set up for Pa
(Pascals ) for pressure and CFM (cubic feet per minute) for flow. If not

use the UNITS button to change or to select your preferred test units.

4. In the Time Ave. window confirm you are set up for 1 second time aver
aging. You may wish to change that later if the readings fluctuate
excessively.

c. With all flow rings attached to fan add the blank off plate to completely seal
the zone.

d. Measure the bias (static) pressure, the difference between inside and outside
the zone.

1. Measure the bias (static) pressure at Discharge Conditions, that is with
the doors of any adjacent rooms in their normal conditions.

2. Measure the bias (static) pressure at Test Conditions, that is with any
adjacent rooms doors open to give a free return air path. (see EIT Quick Test Manual,
page 18, Special Notes, Bias (Static) Pressure.)

3. If subfloor is pressurized at discharge (HVAC system on) then measure
bias (static) pressure between subfloor and outside the protected zone.

Page 2 Fire Safety Technology




4. Conduct the Enclosure Integrity Test —DE-PRESSURIZATION

a. Remove the No-flow plate and install a trial flow ring. For a large zone try using
the open fan (no flow ring), for a very small zone try ring C.

b. Use the CONFIG button to match the flow ring you are using

OPEN Indicates the fan is in the open (no flow plate) configuration.
Al Indicates the A Ring is installed
B2 Indicates the B Ring is installed
C3 Indicates the C Ring is installed

c. Turn on the Blower Door Fan by slowly turning the fan controller clockwise. As
the fan speed increases, room pressure indicated on Channel A should also increase. In-
crease fan speed until you reach the target pressure as shown in the EIT Quick Test soft-
ware. The flow gauge will now display the current cfm. Enter the pressure and cfm in the
EIT software. To make reading the gauges easier, use the HOLD button to freeze the dis-
play.

If the readings are fluctuating excessively, use the TIME AVG button to select a
longer averaging period. TIME AVG cycles through 1, 5, 10 seconds averaging blocks of
data. LONG starts averaging data immediately and continues indefinitely. Use LONG and
watch until readings stop fluctuating.

If you can not reach the target pressure, you must remove a flow ring and using the
CONFIG button match the new flow ring.

If the CFM display blinks LO, install the next smaller flow Ring and select the cor-
rect setting for the new flow ring.

After entering the test pressure (Pa) and flow (CFM) in the computer, turn off the
fan.

*For NFPA 2001/2004 Enclosure Integrity Test Procedure one set of measurements,
flow and pressure is take for both De-Pressurization and Pressurization.

*For NFPA 2001/2012 and 2015 Enclosure Integrity Test Procedures two sets of
measurements, flow and pressure are taken for both De-Pressurization and Pressurization.
5. Enclosure Integrity Test—PRESSURIZATION.

a. Turn fan around so that the chrome grill is facing you and the fan is blowing into
the zone. (Never conduct a pressurization test by reversing the fan using the fan direction
switch if so equipped. Any readings displayed with the fan reversed are invalid.)

b. Using the “T” connector and the short tubing connect the green tube to the
DG 700 as shown:

Pressurization Set Up

Change the green
tube using the “T”

connector ° -
A| | | |B

Red to fan
T i

Grem_,
Page 3 Fire Safety Technology




c. As in 4c., Turn on the Blower Door Fan by slowly turning the fan controller
clockwise. As the fan speed increases, room pressure indicated on Channel A should
also increase. Increase fan speed until you reach the target pressure as shown in the EIT
Quick Test software. The flow gauge will now display the current cfm. Enter the pres-
sure and cfm in the EIT software.

If you can not reach the target pressure, you must remove a flow ring and using
the CONFIG button match the new flow ring.

If the CFM display blinks LO, install the next smaller flow Ring and select the
correct setting for the new flow ring.

After entering the test pressure (Pa) and flow (CFM) in the computer, turn off the
fan.

The EIT Quick Test 2001 software will now indicated the leakage area and the
predicted hold time for the zone.

Again, For NFPA 2001/2004 Enclosure Integrity Test Procedure one set of
measurements, flow and pressure is take for both De-Pressurization and Pressurization.

For NFPA 2001/2012 and 2015 Enclosure Integrity Test Procedures two sets of
measurements, flow and pressure are taken for both De-Pressurization and Pressuriza-

tion.
DEVICE Display [l DG-700 Pressure & Flow Gauge CONFIG Display
PRESSURE Display FLOW Display
MODE Display TIME AVE Display

Fire Safety Technology

P.O. Box 1063
Severna Park, MD 21146 U.S.A.
Phone 800-685-8303, 410-647-8303
FAX 410-647-7066
e-mail: mail@firesafetytech.com
Page 4 For latest information: www.firesafetytech.com
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Test Kit Check List

Review list and equipment before leaving office!

Standard Items included with test kit:

1. Fan in case with:

a. Extension cord

b. “A”, “B”, “C” Rings and Closed Plate
2.  Door Frame in case with:

a. Frame cover (red nylon)

3. Accessory case with:
a. Digital pressure gauge in case with red and green tubes
b. Speed controller
c. Instruction manual with back up CD software disk
d. Smoke tube kit

Additional must have items:

1. Computer with software loaded and 110v power supply
2. Tape measure

Strongly recommended items:

Calculator

Flashlight with spare batteries
Masking tape, duct tape
Current copy of NFPA 2001

Nk

lock wrench

Door stops

Signs, “Do Not Close”,”Do Not Open”

Clip board

. Extra test report forms

10. Extra hand outs of “ How to Seal” and ‘Technical Judgment”
11. Power strip or multi plug adaptor with ground

12. Safety glasses, hard hat, safety shoes, ear plugs if needed at site

\© %0 N o

Tool kit including: Screwdrivers, large enough to remove door closers and large channel

Fire Safety Technology

P.O. Box 1063
Severna Park, MD 21146 U.S.A.

Phone 800-685-8303, 410-647-8303

FAX 410-647-7066

Test Kit Check List.pub e-mail: mail @firesafetytech.com

www.firesafetytech.com



Install blower door frame and fan per instructions. Normal
setup is with technician and gauge inside zone. For setup
outside zone see manual “Setup inside or Outside Zone.”

Depressurization Test:
A. Attach tubes to gauge as shown:

Green to outside | o .
ES
||—|—E Fedto fan

De-pressurization set up

B. Using the DG-700 pressure / flow gauge

1. Using ON/OFF button turn gauge on

2. Press MODE button once to select PR/FL

3. In DEVICE window confirm you are set up for BD 3
fan

4. Inthe pressure and flow windows confirm you are set

up for Pa (Pascals) and CFM (cubic feet per minute)
5. In Time Ave. window confirm you are setup for 1 sec-
ond time
6. Seal fan with no flow plate and read and record in com-
puter the bias (static) pressure if any.
See Bias (Static) Pressure notes on back.
When set up as shown and inside zone:
—(neg) static pressure = air blowing into zone
+ (pos) static pressure = air blowing out of zone
7.  Remove no flow plate and install trial flow ring, large
zone no flow ring, small zone try ring C
8. Use CONFIG Button to match flow ring

9. Turn on fan and bring room pressure to target pressure.

*If you can not reach target pressure remove a flow ring
and reset CONFIG to match
oIf the CFM blinks LO install next smaller flow ring
and reset CONFIG to match
For NFPA 2001/2004 Test at Target Pressure both
depressurization and pressurization.
For NFPA 2001/2012,2015 Test at 10 & 50pa both
depressurization and pressurization.
See Test Procedure notes on back.
10. Use TIME AVE Button to select LONG, wait till
readings stabilize and record—return to 1 second
11. Enter test pressure (Pa) and flow (CFM) in computer
Pressurization Test:
12. Turn off fan and turn around
13. Attach tubes as shown using “T” tube

Redto fan
Green to outside

Pressurization set up

14. Follow above steps to finish test.

Notes on using the DG-700 Digital Pressure/Flow Gauge
and the Model 3 Blower door
NFPA 2001/2004, 2012, 2015

FYI: 1 Pascal (PA) = .004 in wc = .00015 psi

As a quick reminder place this “cheat sheet” on the speed
controller holder behind the DG-700 digital pressure / flow gauge.

For complete details see manual.

cEEEC

T

J me ENERGY J
-ONSERVATORY _ *

- = C —

De-pressurization set up Pressurization set up

with “T” connector

@
Fire Safety Technology
P.O. Box 1063
Severna Park, MD 21146 U.S.A.
Phone 800-685-8303, 410-647-8303. FAX 410-647-7066
e-mail: mail@firesafetytech.com www.firesafetytech.com




Bias (Static) Pressure;
Measure the bias (static) pressure, the difference

between inside and outside the zone.

1. Measure the bias (static) pressure at
Discharge Conditions, that is with the doors of any adjacent
rooms in their normal conditions.

2. Measure the bias (static) pressure at
Test Conditions, that is with any adjacent rooms doors
open to give a free return air path. (see EIT Quick Test
Manual, page 18, Special Notes, Bias (Static) Pressure.)

3. If subfloor is pressurized at discharge
(HVAC system on) then measure bias (static) pressure be-
tween subfloor and outside the protected zone. (see EIT
Quick Test Manual, page 18, Special Notes, Bias (Static)
Pressure.)

Test Procedure:

Turn on the Blower Door Fan by slowly turning the fan con-
troller clockwise. As the fan speed increases, room pressure
indicated on Channel A should also increase. Increase fan
speed until you reach the target pressure as shown in the EIT
Quick Test software. The flow gauge will now display the
current cfm. Enter the pressure and cfm in the EIT software.
To make reading the gauges easier, use the HOLD button to
freeze the display. If the readings are fluctuating excessive-
ly, use the TIME AVG button to select a longer averaging
period.

If you can not reach the target pressure, you must
remove a flow ring and using the CONFIG button match the
new flow ring.

If the CFM display blinks LO, install the next
smaller flow Ring and select the correct setting for the new
flow ring.

After entering the test pressure (Pa) and flow
(CFM) in the computer, turn off the fan.

*For NFPA 2001/2004 Enclosure Integrity Test
Procedure one set of measurements, flow and pressure is
take for both De-Pressurization and Pressurization.

*For NFPA 2001/2012 and 2015 Enclosure Integri-
ty Test Procedures two sets of measurements, flow and pres-
sure are taken for both De-Pressurization and Pressuriza-

tion.
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FST| EIT Quick Test tntl

V 1.0.0.xx
September 2016 Installation Notes

You have or will receive(d) a copy of our new enclosure integrity test program EIT Quick Test Intl
either on a cd or by downloading from a cloud forwarding service Hightail. Following are instructions for
installing the program:

If your have the CD then copy the folder to your computer. You may set up a new folder or just use
the folder from the CD.

If your have received an e-mail from Hightail, open e-mail and click on download, that will take
you to a second screen, click on down load again. That will open a pop up screen with the option open with
Windows Explore or Save file. [ recommend “Save File” which will save the .zip file to your Download
Folder. Create a new folder such as “NFPA Enclosure Integrity Test”. Copy and paste this .zip file to your
new folder. Click on the .zip file and you should see the option to “extract” .zip file. Click extract and the
full program should be extracted to your new folder. If you get a warning about an unknown publisher
click OK or proceed.

To run the program, double click on “Integrity Test.exe “. You may also wish to send it to your

desktop for easy access.

**This program will run with Windows XP, 7, 8.1 and 10. If you have a problem running the pro-
gram you may need to download the Microsoft .NET Framework 4.0 plugin. Go to:

http://www.microsoft.com/en-us/download/confirmation.aspx?id=17851

Once running go to Tools>Preferences and select the folder where you want to save your test files,
often the same as the program folder. You may also set your default Standard or Metric test units. If you
wish you may change individual measurements. Once selected click on “Lock Units of Measurements”
then “Apply and Save”.

Now run the program and explore it. There is a “Demo Test.fst” file, use File>Open to load the
file.

**Printing, as with most Windows programs click on File>Print your should see a print screen that
will allow you to print a “hard” copy or a .pdf (button at bottom). If this does not appear you need to install
the Microsoft Report Viewer:

For Windows XP Service Pack 3, Vista Service Pack 2, & Windows 7: Windows Report Viewer 2010
http://www.microsoft.com/en-us/download/details.aspx?id=6442

For Windows Vista Service Pack 2, Windows 7, Windows 8, Windows 8.1: Windows Report Viewer 2012
http://www.microsoft.com/en-us/download/details.aspx?1d=35747

Or Goggle: Microsoft Report Viewer and pick either 2010 or 2012 version as needed

If you have used our previous program you will find this new EIT Quick Test Intl to have the same
look and feel and be easy for you to use. However there have been some changes in the test procedure in
NFPA 2001/2204, 2012 & 2015 enclosure integrity test procedure. Be sure to read carefully the EIT Quick
Test Manual and the full FST Digital Enclosure Integrity Tester and EIT Quick Test Intl Manual both are
located in the reference folder. Pay attention to the Bias (Static) pressure notes and the two test points for
NFPA 2001/2012 & 2015.

Thank you for your patience. Please notify us of I.'i’e salely reahnal”yy

any problems or suggestions for the program.
yp g8 prog P.O. Box 1063

Severna Park, MD 21146 U.S.A.
Phone 800-685-8303, 410-647-8303
FAX 410-647-7066
Release, Installation Notes rev 9 23 2016 e-mail: mail@firesafetytech.com

www.firesafetytech.com




FST

E1T Quieck Test Intl.

Manual

Index Screen By Screen

.4 Enclosure Integrity Test - DAEIT Program Published Versions warthog\1.0.0.15\FST V1.00.15\PIs0 10 NUEVA seDEfst - © HES
E1T Quiek Test Intl. our program for
E', Q«‘ek ,c,f 'htl enclosure integrity testing per NFPA 2001/

2004, 2012 and 2015. Standard Windows for-

Clean Agent Enclosure Integrity Test and Report mat, easy to understand, easy to use, designed
for quick one step inputting of test data, produc-

A0 ) ing on the spot complete, professional quality

VW FIRESAFETYTECH Com test reports.
P S LSS g suety Tachnolagy

mail@firesafetytech.com

Standards Supported:
NFPA 2001:2004
NFPA 2001:2012
NFPA 2001.2015

Ready

Opening Screen

File Tool: Reference Calculste Retest Help
General | Prtected Zone

Test Information

WD

Date and Time.
Tester

Teat Standard

E17 |
Quick |

1234 We
Ay Town, 0Z 00523

P.0.Box 1063
Sevema Park MD 21146 USA
Phone 800-685-8300. 410-647-8303
FAX410-647-7066

mail@fresafetytech com

.1 Enclosure Integrity Test - DAEIT Program Published Versions warthog\1.00.17\FST 1.00.17\Demo Testfst*
ProTest Crecklt | Test | Gropn | Atendance | Leok Suvey

XYZ0n Lne Services, Computer Room (EIT Guick: Test it Sample Test and Repor)

Ay Town, 0Z 00926

Copyto >

) |

Test file identification
Date, time, technician

Choice of NFPA standard

Customer name and details

Test |

Test Site location and con-

Prone 1224567850 Prone 1226540567 tact
' t 1234567699 Fax 1236540988
Erai Eral  lconpe@sacninesevces com
h(. paser:
Contt Cotact [Me TomBory

Leads
you
through
the
test
procedure
step
by
step,
screen
by

screen

1248 minutes hold time NFPA 2001:2012

Test Information

Protected zone details

Hold time conditions

Gas type and concen-
tration

Test type

EIT Quick Test Intl Manual v17 Rev 10/25/2016

Screen 2 General

Customer and Test Site

1248 minutes hold time.

Enclosure Integrity Test - DAEIT Program Published Versions warthog\1.0.0.15\FST V1.0.0.15\Demo Testfst*

© Standard Total Zone Leskage

)

Calculate  Retest  Help

est Checkist | Test | Graph | Atendance | Leak Survey

Hioh Hazard
(Computer Room. Number 107 Descrption Server racks
Height B
(Computer and serverroom Min Protected Heght B
Protected Volume
L w H
ElS £ 12 18000/ | Clear
o o o o
o o ol o
FM200 v —
Protected Voume | 18000/

Max Fooded (Protected) Heght 2
Installed Suppression Agent
TotalInstaled Wieight o
nstlid Concertration (TR
[ Use this concentration for calculations

Screen 3 Protected Zone
Zone Description

Hold time Condition
Clean Agent Selection

Page 1

Fire Safety Technology

P.O. Box 1063
Severna Park, MD 21146 U.S.A.
Phone 800-685-8303, 410-647-8303
FAX 410-647-7066
e-mail: mail@firesafetytech.com
www.firesafetytech.com




FST

Enclosure Integrity Test - DAEIT Program Published Versions warthog\1.0.0.15\FST V1.0.0.15\Demo Testfst*

EN

I

File Tools Reference Calculate Retest Help
General | Protected Zone | Pre-Test Checklst | Test_| Graph | Atendance | Leak Survey

Pre-Test Checklist
Pretest Extimate

(V] Tanks dsconnected [¥] HVAC system off

7} vl

[¥] Outside air pressure tube connected ] Dampers activated

Commerts

1248 minutes hold fime.

Screen 4, Pre-Test Checklist
Pre-Test Estimate
Comments

Easy to follow “fill

1248 minutes hold time

Screen 5, Test

Hold time vs. height graph
Easy to understand how the
level of the suppression gas
decreases over time.

® Enclosure Integrity Test - DAEIT Program Published Versions warthog\1.0.0.15\FST V1.0.0.15\Demo Testfst* - olEN
Fle Toos Ref Cocte Retest Hep
& Crockie | Text | Gaph | Adearce | Look Savey
Discharge Condiions A Test Condtons Toporatirn Hold Time
s i) Prssre O Bas(Gac)Pesare o e ene GF  Prdcedmentontne 247758
Asblowng ® itozone Acabiowng © o aove Outside Zone o Rl A e i i
G Ot

Eaivoler Leskage Aea 2630 10

[ Cannot Reach 50PA

in the blanks” leads —r s
the technician = =
through the test 2550 2
procedure - -

Test Data and Results

Quiek Test Int(.

ndex Screen By Screen

) |

Pre-Test Checklist
Important do not forget items

Prees Esinae

Fretest madmum alowable leakage area 32871152

‘This prediction assumes a 10 minute hold time

at & minimum protected height of H

Pre-Test Estimate
Calculates maximum leakage area

.1 Enclosure Integrity Test - DAEIT Program Published Versions warthog\1.0.0.15\FST V1.0.0.15\Demo Testfst* - olEd
Fle Toos Reference
ProTot Creckist | Tes| Grooh | Atodance | Lo Srver

Calculate  Retest  Help

Genera | Protecied Zone

1

1208
12447

Hold Time

Hold Height

Heigh (Feat|

55

Time (in minutes)

12.48 minutes hold time.

Screen 6, Graph
Graph
Hold Height vs. Time Table

Fire Safety Technology

Page 2



FST

Enclosure Integrity Test - DAEIT Program Published Versions warthog\1.0.0.15\FST V1.0.0.15\Demo Test.st*
Calculate  Retest  Help

E1T Quick Test Intl.

Index Screen By Screen

EEE

(Genera | Protected Zone | Pre-Test Checkist | Test | Grapn | Atendance | Leak Survey

Authority Having Jurisdiction (AHJ)

123 Man Strest
Ay Town, 00928

Prone  [1284565111
Fax 123456576

Eral  [scon@amtouridon
Other Atendee 1

Name  [WdonGates

Tee Vanage IT Services
Compony [XYZ0n e Servces

1248 minutes hold time:

Other Atendee 2
Neme (W Tom Bary
The Stemanager
Company [XYZ0n L Senvice, e

Other Atendee 3
Name M. Jery Wiol
Tie Presiert

Company [ Wol Cortractng Inc

Other Atendee 4

Name
Tie

Company

Screen 7, Attendance
Authority Having Jurisdiction
Attendees

Attendance

Capture, for the record, the names
and companies of witnesses to the
test including the AHJ if present.

Leak Survey

Should the test fail, the optional
leak survey lists the common leak-
age areas to help guide the cus-
tomer in sealing the zone. This
may or may not be included in the
final test report depending on the
tester’s requirements.

B - |

.1 Enclosure Integrity Test - DAEIT Program Published Versions warthog\1.0.0.15\FST V1.0.0.15\Demo Test.st*
File Tools Reference Calculate Retest Help

General | Proected Zone | Pre-Test Checkist | Test | Graph | Atendance | Leak Survey

[ Conected Yeo
[ Conected Yes
[ Corected Parily | [Pockets on west wallto be scaled
Doors weatherstrpped? [ Conected Yes
Doors. drop seals? [ Comected Yee ] [Meta treshold o be ntaled
Door dosersnstaled and adusted? [ap— Nes
Windows Cauked O Comected None
[ Conectes Reported Yes
[ Conected Reported Yes
Cable trays sesed? 0 Carected None
Allhces, penetrtons seaed? O Corocted Yes
Floor trains rapped andfled? 1 Conscted Noe
Dapers taled onall i dcs? [ Coructod Feported Yes
Dampers working and adusted? 0] Camscted Repored Yes
Block wals pated? [ Conected Mot spicatle

Caingties clpped?

1248 minutes hold time.

Screen 8, Leak Survey
Optional Leak Survey

Fire Safety Technology

Page 3




FST | €17 Quick Test tntl.

Screen 2, General Test Information

B Enclosure Integrity Test - D:\EIT Program Published Versions warthog\1.0.0.17\FST 1.0.0.17\Demo Test.fst* - O u

File Tools Reference Calculate Retest Help

General | Protected Zone | Pre-Test Checklist | Test | Graph | Attendance | Leak Survey

Test Information

Job ID XYZ On Line Services, Computer Room ((EIT Quick Test Intl Sample Test and Report))

Date and Time 7172014 V|| 4221PM

Tester Mark Weathersby

Test Standard NFPA 2001:2012 N

Company Test Site Location

Name XYZ On Line Services, Inc Name XYZ On Line SErvices, Inc.
| Address 1234 Washinton Blvd Address 890 Westpark Dr.
| Any Town, 0Z 00923 Any Town, OZ 00926
i Copyto >>

Phone 123-456-7890 Phone 123-654-0987

Fax 123-456-7839 Fax 123-654-0988

Email mail @xyzonlineservices.com Email computer@xyzonlineservices.com

|
|| Contact Mr. Jon Gates Contact Mr. Tom Berry
|

{
|| 12.48 minutes hold time NFPA 2001:2012

\7

1. Job ID: You may use your company filing system name here or other identifying name. This
will appear at the top of each page of the report.

2. Date and Time: This is taken from your computer however it may be manually changed
should the test be delayed after you have logged in to EIT Quick Test Intl.

3. Tester: The name of the technician actually conduction the enclosure integrity test.

4. Test standard: Here you select the NFPA Test Standard, depending on your local code re-
quirements you have a choice of:

NFPA 2001/2004
NFPA 2001/2012
NFPA 2001/2015

5. Company: this is the name, address etc. for your customer.

6. Job Site Location: In many cases the company name is the company office but the test site is
at a different location: for example your contract may be with Verizon at their local office but the test
site is a cell tower at a different location.

If the test site is the same as the company then simply click the “Copy To” button to transfer the
data
7. Lower left corner: When the test is completed the hold time will show here on all screens as well as
the test standard.

Fire Safety Technology
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E1T Quick Test Intl.

Screen 3, Protected Zone

B Enclosure Integrity Test - D:\EIT Program Published Versions warthog\1.0.0.15\FST V1.0.0.15\Demo Test.fst* = 1= n
File Tools Reference Calculate Retest Help
General | Protected Zone | Pre-Test Checklist | Test | Graph | Attendance | Leak Survey

Zone High Hazard
Name/Number Computer Room, Number 107 Description Server racks
i Location First Floor Height 8|ft
|
Description Computer and server room Min Protected Height 8lft
Hold Time Condition Protected Volume
(® Decending Interface L w H
(O Continuous Mixing 50 ft 30/ft 12/t 18000 ft* Clear
0ft 0/ft 0/ft 0/ft2
Agent 0t 0|ft olft 0|ft
Type FM-200 v —
Design Concentration 72|% Protected Volume 18000/
Mrirn Conceniration 6azj* Max Fooded (Proected) Height 12
Test Type Installed Suppression Agent

®) Standard Total Zone Leakage Total Installed Weight ok

~ Suspended Ceiling Leakage Neutralization Installed Concentration 000 %
~ (Bel ling leakage - BCLA)
(o cera exkage HELY [7] Use this concentration for calculations

12.48 minutes hold time

1. Zone:

Name/Number: If known use the name and/or used by your customer or as noted on your
drawings.

Location: This may be simply “first floor” or “ground floor” but in cases like a large hospi-
tal or college campus it may be “3rd Floor West Hall” or “Schaefer Hall Lower Level”

LR INT LIS

Description: Is the “computer room”, “server room”, “telcon room”, “MRI room” or ?

2. Hold Time Condition:

Descending Interface or Continuous Mixing

If all HVAC systems are shut down prior to discharge and there is no moving air in the zone
the gas/air mixture will leak out the lower leakage areas and fresh air will enter through the high
leakage areas. A layer or interface will form between the gas/air mixture and the fresh air. This inter-
face will drop over time.

If the HVAC systems continue to operate after discharge, the heavy gas/air mixture will leak
out of the lower leakage areas and fresh air will enter through the high leakage area. But since the
HVAC system continues to operate mixing the room air the concentration of the suppression gas
will drop.

See Special Notes, Page 19 Continuous Mixing

3. Agent

Type: This is a drop down listing all the NFPA 2001 clean agents (will all trade names),
Halon, and CO,

Concentration: When a gas is selected the nominal concentration is shown here. However it
is important to check the drawings or contact the system designer to verify the actual design concen-
tration.

Minimum Concentration: In case of “Continuous Mixing” the NFPA 2001 codes allow a
minimum concentration of 85% of the design concentration. This is calculated from the above de-
sign concentration and is only active when “Continuous Mixing” is selected.

Fire Safety Technology
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FST | e Quick Test tntt.

Screen 3, Protected Zone, Continued

5. Test Type:
Standard Total Zone Leakage / Suspended Ceiling Leakage Neutralization
(Below Ceiling Leakage Area -BCLA)

Standard Total Zone Leakage: The zone during test is in it’s normal state with no special
covering of the ceiling.

Suspended Ceiling Leakage Neutralization: The ceiling has been covered with sheet plastic
to block of leakage through the drop ceiling. A technique which can be used when there is excessive
un-sealable leakage area above the drop ceiling or a totally open plenum.

See Special Notes, Page 17

6. High Hazard:

Description: What is the hazard or what is being protected with the suppression gas, i.e.
server racks, UPS, UPS Batteries, computer, art storage, rare books, or ?

Height: What is the height of the protected item? Height is measured from the lowest point
if on the regular floor or slab then from the floor, if on a raised floor then from the slab or floor
under the raised floor.

Minimum Protected Height: Normally this is the same as the Height and is automatically
filled in. However is some cases the AHJ or owner may want the protected height to be higher than
the height of the hazard. This can be changed by typing over. Note: the calculated hold time is
based on this Minimum Protected Height.

Important Note:

Minimum Protected Height is the height of the hazard or the protected property.
Maximum Flooded (Protected) Height is the height of the zone.

The minimum height must always be less than the maximum height

6. Protected Volume:

For a normal cube shaped zone you may enter the length, width, height of up to three con-
nected areas (all in one zone) and the program will calculate the total volume or you may simply
type the total Protected Volume. This will be necessary when the protected volume is a unusual
shape and not a cube. It is useful to sketch the zone and divide into squares, triangle or even is some
case parts of a circle to calculate total volume. It is strongly recommended to do your own measure-
ments on site and not rely on the submitted drawings as often there can be changes in the zone dur-
ing or after construction.

7. Max (Maximum) Flooded (Protected) Height:

In case of a cube shaped zone this is the over all height of the zone. Note: This Maximum
height is always greater than the Minimum Protected Height. If you mistakenly enter a height grater
than the minimum protected height you will get an error message.

In case of more than one connected rooms (one zone) of different heights the program will
calculate an weighted average height of the zone based on the area of each protected room.

8. Installed Suppression Agent:

Total Installed Weight: The total weight of the gas in the tank(s) taken off the label of the
tank. Only used with the gases such as FM-200 which are measured by weight not the high pressure
gasses like nitrogen or Inergen which are measured by volume.

The program calculates the Installed Concentration. You may use this concentration for
calculating hold time by checking the box: Use this concentration for calculations.

Fire Safety Technology
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FS EIT Quick Test Intl.

Screen 4, Pre-Test Checklist, Comments

. Enclosure Integrity Test - D:\EIT Program Published Versions warthog\1.0.0.9\Davis Uimer\Demo Test.fst* = =l
File Tools Reference Calculate Retest Help
General | Protected Zone | Pre-Test Checklist | Test | Graph | Attendance | Leak Survey
Pre-Test Checklist
Tanks disconnected HVAC system off
Free retum air flow path Panel in discharge mode
Outside air pressure tube connected Dampers activated

Pretest Estimate

Comments

Remove the vinyl cove molding and ve|
Install proper jam mourted weather stri|
Install and adjust drop seal (automatic |
Seal windows and frames with clear sil
Install motorized dampers on all HVAC

Remove all tempoary sealing applied d

12.48 minutes hold time

1. Pre-Test Checklist:
This is a reminder list for the testing technician cover a few important items that might be
overlooked. This does print in the test report.

2. Pretest Estimate:
Clicking on the button will bring up the pretest Estimate showing the maximum allowable
leakage area for the zone.

Pt Esmae

Pretest maxdimum allowable leakage area 3.287115|ft?

This prediction assumes a 10 minute hold time =
at a minimum protected height of =

Useful comparing the found leakage area or as guide to the owner or contractor prior to a
test.

3. Comments:
An open field to type in any special comments on the test which will print in the test report.

For example: “All areas temporary sealed (such as with duct tape or plastic sheeting) must
be permanently sealed prior to final acceptance.”
Or “Satisfactory quality weather stripping must be installed on test door
prior to final acceptance.”

4. Comment right field:

We have included a few often used comments. These may be double clicked and added to
the comment field and modified as necessary. If your company has standard clauses or disclaimers
to be included in each report these may be added to the selection. They are entered in the Tools tab.

Fire Safety Technology
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FST | €17 Quick Test ntt.

Screen 5, Test

B Enclosure Integrity Test - D:\EIT Program Published Versions warthog\1.0.0.17\Fire Safety Technology 1.0.0.17\Demo Test.fst* = 1=l n
File Tools Reference Calculate Retest Help

General | Protected Zone | Pre-Test Checklist | Test | Graph | Attendance | Leak Survey

Discharge Conditions At Test Conditions Temperature Hold Time
Bias (Static) Pressure 0pa Bias (Static) Pressure 0|pa Inside Zone sslF Predicted retention time 12.48808| min
Airis blowing (@) into zone Airis blowing (@) into zone Outside Zone sslF At minimum protected height of 3t
(O out of zone O out of zone
Equivalent Leakage Area 2654049 |ft2
Depressurization
Target Pressure 15.7-203
Measured Pressure -10 pa
Measured Flow 1300|cfm
Flow Ring A Y,
Eauiv. Leakage Area | 26540432 2647759 NFPA 2001/2004 Test Screen
Pressurization
Target Pressure 157-203
Measured Pressure 10/pa
Measured Flow 1300{ce
A v

Flow Ring
Equiv. Leakage Area 2654049 |ft2 2647759

12.49 minutes hold time NFPA 2001-2004

1. Bias (Static) Pressure (See “Static (Bias) Pressure Notes” page 18 and “Conducting an Enclosure Integrity
Test, A photo Summary Photo 307, and “Conducting a NFPA 2001 Enclosure Integrity Test Part 2)
Discharge Conditions; This is the static (bias) pressure at discharge conditions. If the gauge is
properly connected enter the pressure from the gauge including the sign (+/-) the program will set the proper
air blowing state which may be difficult to determine visually.
At Test Conditions: This is the static (bias) pressure at test conditions.

2. Temperature:

Inside zone: This is the temperature of the protected zone. If this is a computer/server room with spe-
cial HVAC systems the temperature may be taken off the HVAC control system.

Outside Zone: This is the temperature of the area surrounding the protected zone, often the office
area. Not “outside” the building unless the protected zone is something like a cell site control building (box).

3. Hold Time:
Will be calculated by the program when the test is completed.

4. Test Data:

NFPA 2001/2004 Enclosure Integrity Test

(see “Conducting a Enclosure Integrity Fan Test, a Photo Summary, “The Cheat Sheet” and ? )

The 2004 code requires both a depressurization and pressurization test at one pressure within the Tar-
get Pressure range.

With the fan in the door panel and the gauge properly connected and tester inside the zone

Start by depressurizing the zone, that is with the white flow rings facing you and the fan blowing out.
For a small zone that is well sealed start with the C ring, with large zone start with the A ring. Turn fan on and
bring up to target pressure range. If you can not reach the target pressure turn fan off and remove one flow
ring. If the flow reading flashes LO LO LO, turn fan off and add a flow ring.

When pressure and flow stabilize record Measured Pressure and Measured Flow readings along with
Flow Ring which is a drop down selection.

Turn fan around a repeat above steps. Most often the fan flow ring configuration will be the same but
sometimes you make have change the flow rings.

Fire Safety Technology
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FST | 17 Quick Test tnte.

Screen 5, Test

Lo Enclosure Integrity Test - D:\EIT Program Published Versions warthog\1.0.0.17\Fire Safety Technology 1.0.0.17\Demo Test.fst* = = n
File Tools Reference Calculate Retest Help
General | Protected Zone | Pre-Test Checklist | Test Graph | Attendance | Leak Survey

Discharge Conditions At Test Conditions Temperature Hold Time
Bias (Static) Pressure 0/pa Bias (Static) Pressure 0/pa Inside Zone 68lF Predicted retention time 12.47799 | min
Airis blowing (@) into zone Airis blowing (@) into zone Outside Zone 68/F At minimum protected height of sl
*) out of zone O out of zone
> Equivalent Leakage Area 2654049 ft2
Depressurization [7] Cannot Reach 50PA
Target Pressure -10pa -50pa
Measured Pressure -10 pa -50 pa
Measured Flow 1300 |cfm 2500 | cfm
Flow Ring A v A v
Bt aa T S NFPA 2001/2012, 2015 Test Screen
>
Pressurization
Torget Pressure ilpa SLE
Measured Pressure 10jpz e
Méasixnd How 1300 | cfm 2500 cfm
Flow Ring A M A b
Equiv. Leakage Area 2654049 ft2 2647759 |ft2

12.48 minutes hold time NFPA 2001:2015

NFPA 2001/ 2012, 2015 Enclosure Integrity Test

(see “Conducting a Enclosure Integrity Fan Test, a Photo Summary, “The Cheat Sheet” and
“Conducting a NFPA 2001 Enclosure Integrity Test Part 2 )

The 2012 and 2015 code requires two depressurization tests and two pressurization tests at 10pa and
50pa.

With the fan in the door panel and the gauge properly connected and tester inside the zone

Start by depressurizing the zone, that is with the white flow rings facing you and the fan blowing out.
For a small zone that is well sealed start with the C ring, with large zone start with the A ring. Turn fan on and
bring up to 10pa. If you can not reach 10pa turn fan off and remove one flow ring. If the flow reading flashes
LO LO LO, turn fan off and add a flow ring.

When pressure and flow stabilize record readings along with flow ring.

Repeat above step and depressurize to 50pa. Often you may have to change flow rings to reach 50pa.

Turn fan around a repeat above steps. Again you may have to change flow rings to meet the required
test pressures.

When both depressurization and pressurization data are entered the calculated hold time will show in
the upper right hand corner and the lower left hand corner on all screens.

The NFPA code requires a 10 minute hold time but a lesser time may be approved by the local AHJ
depending on several factors.

Fire Safety Technology
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FST

1

"

| &

File Tools

Reference

Enclosure Integrity Test - D:\EIT Program Published Versions warthog\1.0.0.15\FST V1.0.0.15\Demo Test.fst*

Calculate

Retest

General | Protected Zone | Pre-Test Checklist | Test

Hold Height

12.008 Feet
11.385 Feet
10.794 Feet
10.203 Feet
9.613 Feet
8.99 Feet
8.399 Feet
7.808 Feet
7.185 Feet
6.594 Feet
6.004 Feet
5.413 Feet
4.79 Feet
4.199 Feet
3.609 Feet
2.986 Feet

12.48 minutes hold time

Hold Time

0min
1.77 min
3.51 min
5.3 min
714 min
9.15min
11.11 min
13.15min
15.38 min
17.59 min
19.9 min
22.32 min
25.03 min
27.76 min
30.69 min
34.06 min

Height (Feet|

Help

E1T Quick Test Intl.

Graph | Attendance | Leak Survey

Screen 6, Graph

08 ‘
17385
=.10.794
®.10.203
®.9613

".899

=.B.399

7.808

w.7.185
=.65%

. 6004

479
= 4199
.

3508

2986
-

Graph and Hold Height vs. Hold Time Table

When the test is complete the program produces the above graph and table. The graph is

20

Time (in minutes)

very useful to show the rate that the interface is falling in the zone.

By moving the slider 1 the graph may be adjusted to the best presentation of the data.

Note: The graph function only is available for the heavy gases i.e. FM-200.

Page 10
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FST

. Enclosure Integrity Test - D:\EIT Program Published Versions warthog\1.0.0.15\FST V1.0.0.15\Demo Test.fst*

File Tools Reference Calculate Retest

General | Protected Zone | Pre-Test Checklist | Test

Authority Having Jurisdiction (AHJ)

Name Lt. Stan Car
Title Inspector, Fire Prevention Division
Company Any Town Fire Department
Address 123 Main Street

Any Town, 00928
Phone 123-456-9111
Fax 123-456-8766
Email scar@anytownfd.org
Other Attendee 1
Name Mr. Jon Gates
Title Manage IT Services
Company XYZ On Line Services

12.48 minutes hold time

Attendance

E1T Quick Test Intl.

Screen 7, Attendance

Help
Graph | Atendance | Leak Survey

Other Attendee 2

Name
Title

Company

Mr. Tom Bamy

Site manager

XYZ On Line Services, Inc.

Other Attendee 3

Name
Title

Company

Mr. Jemy Wolf
President

Wolf Contracting, Inc

Other Attendee 4

Name
Title

Company

- N

Add the names of individuals who are present at the test, including any company employees
that may be assisting the testing technician. These names will be printed in the test report.

Note: It is recommended that the Enclosure Integrity Test Data Form is used to make a hard
copy of the test data in case there is a computer problem and loss of the test data.

It is easy to pass around the last page of the Data Form and have the individuals fill in their

names and company.

Page 11
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FST | 17 Quick Test tnte.

Screen 8, Leak Survey

B Enclosure Integrity Test - DAEIT Program Published Versions warthog\1.0.0.15\FST V1.0.0.15\Demo Test fst* - oIEN
File Tools Reference Calculate Retest Help

General | Protected Zone | Pre-Test Checklist | Test | Graph | Aftendance  Leak Survey
Wals floor to deck?

[] Comected Yes v -
Walls caulked at floor? [] Comected Yes v
Wealls caulked at deck? [] Comected Partially v | |Pockets on west wallto be sealed
Doors weather-stipped? [J Corrected Yes v
Doors, drop seals? [] Comected Yes v | | Metal thresholds to be installed
Door closers installed and adjusted? [] Comected Yes v
Windows Cauked [ Comected None v
Exiting conduits sealed? [ Comected Reported Yes v
Exiting cables sealed? [] Comected Reported Yes v
Cable trays sealed? [] Comrected None v
Allholes, penetrations sealed? [ Comected Yes v
Floor drains trapped and filled? [] Comected None v
Dampers installed on all extting ducts? [ Comected Reported Yes v
Dampers working and adjusted? [ Comected L v
Block walls painted? [] Comected Not Applicable v
Ceiling tiles clipped? R Voo & V

12.48 minutes hold time

Leak Survey

If the zone does not meet the required hold time it is due to too much leakage. The tester
can by both observation based on his experience and by using the door fan and smoke help identify
the leakage areas.

The survey form list the most common leakage areas with room for comments.

The completed form can be very helpful for the owner and/or contractor.

If the owner and/or contractor has not already received a copy of “Sealing of Rooms for
Containment of Fire Suppression Agents” a copy should be included with the test report.

Again it is recommended that the above survey is completed manually on the Test Data
Form and copied into the computer form later.

Fire Safety Technology
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ST | e Quick Test ntt.

Toolbar: File, Tools

o Enclosure Integrity Test - DAEIT Program Published Versions warthog\1.0.0.15 B 2.0\Sample
File  Tools Reference Calculate Retest Help

General | Protected Zone | Pre-Test Checlkdist | Test Graph | Attendance | Leak Survey
Test Information

EIT Quick Test Intl. is formatted in the very familiar standard Windows format including a toolbar
making it easy to learn and use.

o Enclosu
File | Tools Reference
New  Ctrl+N File
Recent 3 The standard Windows functions New, Open,
Open Ctrl+0 Close, Save, Save As, Print, Exit.
Close Ctrl+W
. OHES Also included is Recent, useful in quickly finding
Print Ctrl+P
Bit  CtrleX
Tools
Tools | Reference Calculate R Preference for setting and locking your
O desired units and adding standard comments to the
comment field.
Install License Install License
Spell Check F7 Only used is moving program from one
folder to another or changing computers.
Agent Percent Calculator Spell Check

Useful especially when making comments
in the comment field.
Agent Percent Calculator

No longer being used

Fire Safety Technology
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FST | €17 Quick Test ntt.

Toolbar Tools>Preferences

of Enclosure Integrity Test - DAEIT Program Published Versions warthog\1.0.0.15 B 2.0\Sample
File Tools Reference Calculate Retest Help

General | Protected Zone | Pre-Test Checklist | Test | Graph | Attendance | Leak Survey
Test Information

Preferences

Default Save Location: Browse
o| Defaul Test Standard |NFPA 2001:2012 v
!
Clear recent files from menu
g
groupBox1
Set Al Standard Set Al Vet pacoedjen
andar
= [Remove the vinyl cove molding and vacuum and caulk the sheet rock wall
to floor joint the entire perimeter of the zone
Length O Feet Install proper jam mounted weather stipping on door.
Area oje a2 Install and adjust Hrop seal (automatic seal) on door.
Volume o |Seal windows and frames with clear siicone caulk.
Time Ofmin  Minute Install motorized dampers on all HVAC supply and retum ducts and
|connect to fire suppression panel to close prior to discharge.
Pressure Olpa  Pascal
Remove all tempoary sealing applied during test (plastic sheeting, blue
Flow Olcfm  f%/min tape) and replace with proper sealing materials.
Weight [ Pound
Temperature 32|F Fahrenheit

[7] Lock unit of measurement

Cancel i Apply and Save ;

Tools>Preferences

Default Save Location: Normally the program will save your test files in the same
folder as the program. If you wish to same the test files in a different folder you may select it
here.

Default Test Standard: You may set your preferred test standard here. You may
always change it for a specific test requirement in the General screen.

Clear recent files from the menu: Click this button to clear the files that come up
when Recent is selected in File.

Group Box 1: The program may be run in many different units, metric, standard
(also known as Imperial or SAE) or a mix of units depending on your preference. You may
Set all Standard or Set all Metric by clicking on the button or you may select or change an in-
dividual unit.

Lock unit of measurement [Important]: Once you have selected your preferred
units check this box (or uncheck if you need to change the units). If this is not checked you
may inadvertently change the units while working in the program and not realize it.

Predefined Text: We have included standard comments which we have often needed to
include in the test report. You may add any of these to your report by double clicking on the
comment. You may also add your own standard comments (boiler plate) which will appear in
Screen 4 and may be double clicked to add them to the comment field.

Apply and Save: Click this button after any changes of units or Predefined Text.

Fire Safety Technology
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FST | €7 Quick Test tntt.

Toolbar: Reference, Calculate

of Enclosure Integrity Test - D:AEIT Program Published Versions warthog\ 1.0.0.15 B 2.0\Sample
File Tools Reference Calculate Retest Help

General | Protected Zone | Pre-Test Checklist | Test Graph | Attendance | Leak Survey
Test Information

Reference | Calculate Retest Help

Calibration Certificates » .

: Reference: A collection of our handouts and
15 FST Sealing of Rooms rev 02 2012,pdf . .
Calibration Requirements and Service Packet 8 2015 helpful documents in .pdf format which you are
e ! welcome to read, print and give to your customers.
Closed Sign.PDF .
Cunductiig a Enclosure Integrity Test Phote Summary.pdf EspeCIally useful fOI’ your customers and
Dragon Puffer Air Flow Instructions pdf contractors is our document on sealing a zone

EIT Intl Release note 1 2015.pdf
EIT QT Intl Special Feature Calibration Certificates.pdf

“Sealing of Zones”

EIT OT Points o remember pof o Useful and recommended for the testing
E‘Tf”"“‘TT“"_:'y enl 3106l technician is ”Enclosure Integrity Test Data Form”
e T = for collecting a hard copy of the test data should
END USER LICENSE AGREEMENT pef your have a computer problem and lose the test da-
Excessive above ceiling leakage..pdf
ta.

Finding Leakage Areas.pdf e
FST Enclosure Integrity Test Procedure rev 8 24 15.pdf
o el ot Roome v B et Calibration Certificates: V 1.0.015+ Contains

e — o .
old EIT uick Test Inf Manusl 11 16 2015.pdf e the calibration certificates for your fan and gauge.
cld END USER LICENSE AGREEMENT.ocf They will pop up in Help should you need to show
Open Sign.PDF . .
Requirements for Enclosure Integrity Test 2008, pdf them to an AHJ When a gauge 18 rec.ahbra‘ged, scan
Room Leakage Survey Form.2DF = the new certificate as a .pdf and add it to this folder.

Sample Test Report.PDF fli:
Special Feature Calibration Certificates.pdf
Technical Judgement.PDF

Technical judgment addendum with instructions,pdf E
Technical Judgment Sample Report.pdf
Test Kit Check List.pdf

Zone Placard.PDF

Calculate: Forces a recalculation of the hold time. Whenever there is

Calculate new data or a change of data entered the program recalculates. However

Test Checkdist sometimes it may seem that there was no recalculation. Clicking on Cal-
culate forces a recalculation

Fire Safety Technology
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FS EIT Quick Test Mntl.

Toolbar: Retest, Help

o Enclosure Integrity Test - DAEIT Program Published Versions warthogy1.0.0.15 B 2.0\Sample
File Tools Reference  Calculate Retest  Help
General | Protected Zone | Pre-Test Checklist | Test | Graph | Attendance | Leak Survey
Test Information

Retest: One of our most useful features. Of-
Retest ten you will be retesting a zone, either the same
Test |G day or later after there is additional sealing: Re-
test allow you to delete portions of the earlier
test so that you do not have start from scratch or
manually delete certain data fields and you can
select just which fields to delete.

B Reias: Test Data: Only erases the last test data.

Select data to reset/revert to 0

[7] Test Data (Pressures and Fows) Protected Zone Data: If you are going to test

[[] Protected Zone Data

ST another zone in the same facility at the same
[ Leak Survey date you would check both Test Data and Pro-
L] Atendence tected Zone Data and add the Zone Data for the
new zone and do a test.
Cancel
Pretest Check List:
Leak Survey:

Attendance: All function as above.

About EIT Quick Test Intl. Help>About: Basic data about your copy
EIT Guik Test i of EIT Quick Test Intl. including Version,
Verson 1,015 License Number, Gauge and Fan Serial Num-
TR Gage DGO bers, and your company details.
TEC Blower Door Model 3 #654321
Copyright = 2014, 2015 by . . .
Fire Satety Technology. Div Woridwide Trade and Services. Click for License Agreement: Bringsup a
Usencd o ABC Fr o Sy, . copy of the license agreement.
Anytown, ST 12345
gz . . . . .
24567091 Calibration Certificates: Brings up copies
of your calibration certificates, and infor-
Gk for cense Agaemert mation sheets on calibration requirements and
Cobraton Coticaes recalibration order forms.
ok ]

Fire Safety Technology
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FST| e Quick Test tntt.

Special Notes

Suspended Ceiling Leakage Neutralization (Below Ceiling Leakage Area-BCLA)

Test Type ]
(® Standard Total Zone Leakage

 Suspended Ceiling Leakage Neutralization
~~ (Below ceiling leakage - BCLA)

Test Type: In screen 3, Protected Zone , Test Type you have the choice between Standard
Total Zone Leakage and Suspended Ceiling Leakage Neutralization (Below Ceiling Leakage Area—
BCLA)

Almost all tests are “Standard Total Zone Leakage”, that is we test the entire zone high and
low for leakage.

The Suspended Ceiling Leakage Neutralization (Below Ceiling Leakage Area— BCLA) test
is a special test used in cases where there is excessive above ceiling leakage areas, for example in a
case where the side wall do not go to the over head deck and there is an open plenum covering the
entire building area or where the walls do go to the overhead deck but are not sealed at the deck
and/or there are above ceiling holes in the side walls.

We know that the gases are heavy and leak out of the lower leakage areas. In calculating
hold time the standard procedure assumes that half of the found leakage area is high and half is
low. The size of the low leakage area and the weight of the gas/air mixture determines the rate of
leakage.

However when we test a zone with a drop ceiling and an open plenum the found leakage
area is not half high and half low but normally the high leakage area is much greater than the low
leakage area.

In order to correct for this difference there is a special test procedure.

First we test the zone in the normal way with all ceiling tiles in place.

Second we cover the ceiling with plastic sheeting and retest the zone (the BCLA test)

The program then calculates the hold time.

After selecting the Suspended Ceiling Leakage Neutralization (Below Ceiling Leakage Area—
BCLA) option when you select the Test tab you will see data fields for both tests.
For more information NFPA 2001/ 2004 C.2.6.2 or NFPA 2001/2012, 2015 C.2.7.2

B Enclosure Integrity Test - D:\EIT Program Published Versions warthog\1.0.0. " Enclosure Integrity Test - D:\EIT Program Published Versions warthog\1.0.0.15 B 2.0\Sample Test Report\Demo Testf:
File Tools Reference Calculate Retest Help File Tools Reference Calculate Retest Help
General | Protected Zone | Pre-Test Checkist | Tost | Graph | Aftendance | Leak Survey General | Protected Zone | Pre-Test Checkist | Test | Graph | Atendance | Leak Survey
Discharge Conditions. A Test Conditions Temperature Discharge Conditions At Test Conditions. Temperature
Bias (Statc) Pressure -15)pa Bias (Stalc) Pressure 1.3[pa Inside Zone Bias (Staic) Pressure 15]pa Bizs (Staic) Pressure -1.3)pa Inside Zone 6|F

Hiris blowing @) into zone Hiris blowing @) into zone Outside Zone Hiris bowing @ into zone Hirisblowing @ into zone Outside Zone 3
O otof zone O otof zone O out of zane O outof zone

Depressurization [ Cannet Reach 50PA Depressurization [ Cannot Reach 50PA
Target Fressure 10-13 (Total leakage) 10-13BELY Terget Pressure -10pa (Total leakage) ~50pa (Total leakage) “10pa (BCLA) 50pa (BCLA)
Measure: d Pressure 0lpa 0lpa 0 Measurex d Pressure 0/pa 0lpa 0/pa 0/pa
Weastred Flow 0)cim 0]cim 0 Measured Fow 0]cim 0]cim 0]cfm 0]cim
Flow Fing n - - Flow Fing
Eauiv. Leakage Area o o) 0 Equiv. Leakage Area o 0 ol o)
Pressurization Pressurization
Target Pressure 10-73 (Total leskage) 10-13BCLAY T 10pa (Total leakage) 50pa (Totalleakage) 10pa (BCLA) 50pa (BCLA)
Messured Preseurs Oee Olpa g Measured Pressure Yjpa Oipa Ojpa Ojpa
Measured Flow Em ol 0 Meastred Flow 0 0l 0]cfm 0] fm
Flow Ring A hd S Flow Ring
Equiv. Leakage Area e 0 0 Equiv. Leakage Area o ol o) ol
NFPA 2001/2004 BCLA Test NFPA 2001/2012,2015 BCLA TEST

Fire Safety Technology
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Special Notes

Bias (Static) Pressure:

The bias or also known as static pressure is the pressure acting on the zone, that is pressure
or de-pressure out side the zone. This may be due to building HVAC systems, possibly due to an
unbalanced system creating a negative or positive pressure in the area outside the zone, or wind ef-
fect on the building, a special lab or kitchen exhaust located near the protected zone or even fluctua-
tions of air pressure due to the elevators.

Excessive bias pressure could shorten the predicted hold time by sucking or forcing out the
gas/air mixture at an accelerated rate. By code the bias pressure must not exceed 25% of the pressure
created in the zone by the gas/air mixture, the target pressure in NFPA 2001/2004 (and is calculated
with warnings in EIT Quick Test Intl for NFPA 2001/2012, 2015).

The NFPA 2001 Enclosure Integrity Test Procedure has always required measurement of the
bias pressure. See “Conducting an Enclosure Integrity Test, Photo Summary” photo 30, and
“Conducting a NFPA 2001 Enclosure Integrity Test, Part 2”

The test procedure always required the zone and the area to be in the expected discharge
condition when the test is conducted. The test is conducted with dampers, HVAC, doors, etc. in the
discharge state, but beyond these items it is of course impossible for the tester to accurately predict
the state of the zone or surrounding area at the time of an emergency.

The exception to this is in the case where we have opened a normally closed door to an ad-
joining room in order to obtain a free return air path during the test. Therefore in such case measure
the bias pressure with the door closed, then open it for the test.

If the underfloor is pressurized at discharge (HVAC system on) then measure bias (static)
pressure between the underfloor and the area outside the protected zone with HVAC on.

NFPA 2001/ 2012 and 2015 require the entry of both the bias pressure at discharge condi-
tion and at test condition. Unless there is a situation with an adjoining zone enter the normally meas-
ured bias pressure for both the discharge and at test condition.

See below C.2.6.2 from NFPA 2001/2012,2015

C.2.6.2 Bias Pressure Measurement.

C.2.6.2.1 Bias pressures are the background pressures that
exist in the enclosure when the fan is stopped and sealed. Bias
pressure must be measured or estimated for two different con-
ditions. The first condition (which can always be measured) is
the bias pressure present during the actual enclosure integrity
test (P,). The second condition (which may need to be esti-
mated) is the bias pressure expected after discharge, during
the hold time (£,,). To measure bias pressure, seal the fan
opening with the door fan properly installed but without the
fan operating. Observe the room pressure gauge for at least
30 seconds. Look for minor fluctuations in pressure. Deter-
mine the flow direction with smoke or other indicating
method.

C.2.6.2.2 With the room set up as it would be under hold
time conditions, measure the bias pressure P,, across a section
of envelope containing the largest quantity of leaks expected
to leak clean agent. If the subfloor is pressurized during the

hold time, measure the differential between the subfloor and
outside the envelope. If the room cannot be set up as would be
under discharge conditions, P,, will need to be estimated.

C.2.6.2.3 With the room set up for the room integrity test,
measure the bias pressure P,,. If P,, has an absolute value
greater than 25 percent of the column pressure calculated in
C.2.7.1.4, it must be permanently reduced. Large bias pres-
sures decrease the level of certainty inherent in this proce-
dure. The most common causes of excessive bias pressure are
leaky dampers, ducts, and failure to shut down air-handling
equipment serving the enclosure.

C.2.6.2.4 Record the position of all doorways, whether open
or shut, when the bias pressure P,, is measured.

Fire Safety Technology
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Special Notes

Continuous Mixing:

It is normally recommended that all HVAC systems, computers, UPS equipment, switch
gear etc. in the protected zone be shut down (de-powered) prior to discharge of the fire suppression
gas. It is easy to understand that in case of a fire emergency shutting down this equipment this
would minimize the risk of damage to the equipment and minimize the risk of re-ignition. There
have been cases in which the HVAC / air handlers have been the source of smoke setting off the fire
suppression system.

However some owners demand that the equipment and in particular the HVAC system is
not shut down. In such cases because the air handlers are operating and moving air in the zone one
has a situation referred to as “continuous mixing” of the suppression gas / air mixture. This is differ-
ent from the standard discharge condition where the interface of the gas / air mixture is falling in the
zone at a predictable rate. Briefly with “continuous mixing” there is a loss of the gas / air mixture
out of the lower leakage areas but due to the mixing action of the air handlers the percentage of the
suppression gas in the whole zone decreases. For this condition the calculation of the “hold time” is
different from the standard Enclosure Integrity Test Procedure. We actually need to calculate the
time lapse, “hold time” until the falling concentration reaches the minimum acceptable concentra-
tion.

NFPA 2001 /2012, 2015 5.6 and C.2.8.1.5 requires a minimum of 85% of the design con-
centration be held in the zone for 10 minutes.

If you have a zone with a continuous mixing then In the Protected Zone Screen, Hold Time
Condition click Continuous Mixing. EIT Quick Test Intl. will then calculate the hold time using the
Minimum (Allowable) Concentration.

Fire Safety Technology
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EIT Quick Test Intl. © Enclosure Integrity Test
Test Data Form

Enclosure Integrity Test
Date: Contract: Job #:

Customer:

Address:

City: State: Zip:

Contact: Phone: FAX:

Site:
Building:
Address:

City: St: Zip

Contact: Phone: FAX:

Zone:

Test Standard: NFPA 2001/2004 NFPA 2001/2012

Room, Location:

Description:

Other fire protection: |Sprinklers y /n Type pre-action or ?

Security: Zone y/n Type: Cameras? or Buildingy/n  24/7 y/n  Type:

Suppression gas:

Trade name: Concentration: Weight, volume: Manufacture:

Control Panel mfg: Model: Installer:

Heights:

Raised floor ht.: Floor to drop Drop ceiling to
ceiling: upper deck:

Total protected

height:

High hazzard, Height of high

description: hazzard:

Minimum Per (AHJ or ?):

protected height:

Volume:

Overall protected volume: Volume of solid objects:

Net Protected volume: Floor area:

Page 1



Temperature:

Outside temperature is the temperature surounding the zone, not necessairly
outside the building

Temperature inside zone:

Temperature outside zone:

Free return air flow path

Must have open air path from outside zone walls back to fan

Confirmed:

Test Set Up Door:

Weather stripped?

Drop seal / door sweep?

Door Closer?

Pretest, Maximum Leakage:

Based on the zone’s specfications, the calculated maximum allowable leakage

for a 10 minute hold time (0.00 static pressure)

Maximum leakage:

Static air pressure

Must be less than 25% of target test pressure
+ Positive if blowing out of zone, - Negative if blowing into zone
**BE SURE OUTSIDE SAMPLING TUBE IS THROUGH DOOR PANEL**

Static air pressure:

Discharge Condition

Test Condition

Hold Time Condition:

Test Type

Descending Interface

Continuous Mixing

Standard Total Zone

Leakage

Suspended Ceiling Leakage
Neutralization (Below ceiling

Leakage BCLA)
EZ?;: NFPA 2001/2004: Use indicated target pressure
NFPA 2001/2012: Use 10pa & 50pa, if can not reach 50 pa check box and test at 10 pa
Depres Target pressure: Press: Target pressure:
Test pressure: Test pressure:
Flow: Flow:
Low Flow Plate: Low Flow Plate:
Test Results:
Total leakage Sq Inches: Sq Feet:
Hold time Height (ft): Minutes:
Height (ft): Minutes:
Height (ft): Minutes:
Height (ft): Minutes:

Page 2




DRAWING:

17=.083 27 =.1663"=.25 4°=333 5°=416 6”=50 7°=.583 8 =.666 9”=.75 10”=.833 11”=.9166
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Possible leakage areas

Problem area

Y/N (1)

Corrected

Comments

Walls floor to deck

Walls caulked at floor

Walls caulked at deck

Doors weather-stripped

Doors, drop seals

Door closers installed, adjusted

Windows caulked

Exiting conduits sealed

Exiting cables sealed

Cable trays sealed

All holes, penetrations sealed

Floor drains trapped and filled

Dampers installed on all exiting
ducts

Dampers working and adjusted

Block walls painted

Ceiling tiles clipped

HVAC shut down

Halon exhaust dampered

Halon exhaust damper closed

1. Y—yes
N— No
R—-Reported

?2—-Unknown
N/A—Not Applicable
I/A—-Inaccessible

Page 4




Attendance at test:

Name

Company / Department

New test report form.pub

EIT Quick Test 'hfl.© is produced by:
Fire Safety Technology

P.O. Box 1063
Severna Park, MD 21146 U.S.A.
Phone 800-685-8303, 410-647-8303
Cell 443-928-8567
FAX 410-647-7066
e-mail: mail@firesafetytech.com
www.firesafetytech.com
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NFPA 2001:2012
Clean Agent Enclosure Integrity Test

Conducted by:

ABC Fire and Safety, Inc.

1234 Main Street
Anytown, ST 12345

123-456-7890

123-456-7891

WWW.ABCFIRENSAFETY.COM

Tuesday, July 1, 2014 4:22 PM

XYZ On Line Services, Computer Room ((EIT Quick Test Intl Sample Test and Report))



Enclosure Integrity Test Report

XYZ On Line Services, Computer Room ((EIT Quick Test Intl Sample Test and Report))

General
Test Date 7/1/2014 4:22:21 PM
Tested by Mark Weathersby
Job ID XYZ On Line Services, Computer Room ((EIT Quick
Test Intl Sample Test and Report))
Company
Name XYZ On Line Services, Inc
Address 1234 Washinton Blvd.
Any Town, OZ 00923
Contact Mr. Jon Gates
Phone 123-456-7890
Fax 123-456-7899
E-mail mail@xyzonlineservices.com
Location
Name XYZ On Line SErvices, Inc.
Address 890 Westpark Dr.
Any Town, OZ 00926
Contact Mr. Tom Berry
Phone 123-654-0987
Fax 123-654-0988
E-mail computer@xyzonlineservices.com
Protected Zone
Name/Number Computer Room, Number 107
Location First Floor
Description Computer and server room
High Hazard
Description Server racks
Height 8 Feet
10/26/2016

ABC Fire and Safety, Inc.

2457650.1

Version 1.0.0.17



Enclosure Integrity Test Report
XYZ On Line Services, Computer Room ((EIT Quick Test Intl Sample Test and Report))

General
Protected Volume 18000.000 ft3
Maximum Protected Height 12.000 Feet
Minimum Protected Height 8.000 Feet
Temperature Inside Zone 68.0 Fahrenheit
Temperature Outside Zone 68.0 Fahrenheit
Static Pressure (test) 0.000 Pascal
Static Pressure (discharge) 0.000 Pascal

Test Standard

Name NFPA 2001:2012
Hold Time Condition Descending Interface
Test Type Total Zone Leakage

Suppression Agent

Name FM-200 (HFC-227ea)

Gas Design Concentration 7.2%

Hold time calculations based on the design concentration of the supression agent.

Maximum Allowable Leakage: 3.287 ft2

Depressurization

Target -10pa -50pa
Pressure -10.0 Pascal -50.0 Pascal
Flow 1300.00 ft3/min 2900.00 ft3/min
Leakage 2.654 ft2 2.648 ft2
Area

Pressurization

Target 10pa 50pa
Pressure 10.0 Pascal 50.0 Pascal
Flow 1300.00 ft3/min 2900.00 ft3/min
Leakage 2.654 ft2 2.648 ft2
Area

NFPA 2001, 2012 edition, Annex C, Enclosure Integrity Procedure

Predicted Hold Time at 8 Feet 12.48 Minutes

2
Equivalent Leakage Area: 1.875 ft

10/26/2016 2457650.1

ABC Fire and Safety, Inc. 3 Version 1.0.0.17



Enclosure Integrity Test Report
XYZ On Line Services, Computer Room ((EIT Quick Test Intl Sample Test and Report))

14 - —=— Descending Interface Height
Maximum Protected Height
—e— Minimum Protected Height

124

Height (Feet)
| |

0 ‘ ‘ ‘
0 10 20 30

Time (in minutes)

Height (Feet)  Time (minutes)

12.008 0
11.385 1.77
10.794 3.51
10.203 53
9.613 7.14
8.99 9.15
8.399 11.11
7.808 13.15
7.185 15.38
6.594 17.59
6.004 19.9
5.413 22.32
4.79 25.03
4.199 27.76
3.609 30.69
2.986 34.06
10/26/2016 2457650.1

ABC Fire and Safety, Inc. 4 Version 1.0.0.17



Enclosure Integrity Test Report
XYZ On Line Services, Computer Room ((EIT Quick Test Intl Sample Test and Report))

Authority Having Jurisdiction

Name Lt. Stan Carr
Contact Inspector, Fire Prevention Division
Address 123 Main Street

Any Town, 00928

Phone 123-456-9111

Fax 123-456-8766

E-mail scarr@anytownfd.org

Other Attendees
Name Mr. Jon Gates
Title Manage IT Services
Company XYZ On Line Services
Name Mr. Tom Barry
Title Site manager
Company XYZ On Line Services, In